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Using the Section Editor
To understand what the Section Editor is and how it works, let’s review how a 
corridor is built. An alignment and a profile are combined to create a 3D chain, 
and then an assembly is repeatedly inserted along that 3D chain to create the 
full model. As you construct the assembly, you’re looking at a static version of 
the cross-sectional geometry of the road. This version doesn’t reflect the way in 
which the subassemblies interact with the targets you have assigned to them. 
However, the Section Editor enables you to view each assembly insertion in 
cross-section view, including any interactions involving targets. In addition, you 
can use the Section Editor to make edits to each corridor section and perfect 
your design down to the smallest detail.

When you click Section Editor on the ribbon, a Section Editor tab pro-
vides you with the tools you need to configure and navigate in the editor (see 
Figure 10.1). It can be very helpful to divide your drawing area into two or three 
viewports so you can see the section viewer alongside the “normal” view of your 
drawing. In fact, a great feature of the tool is that it displays a marker on the 
alignment and profile that indicates the location of the section you’re viewing. 
Thus, with three viewports available (plan, profile, and section), you can view 
your design from three different perspectives at once.

F i g u re    1 0 . 1    The Section Editor ribbon tab

As the name implies, you can also use the Section Editor to edit your corridor 
design. This is done with the Parameter Editor command found on the Section 
Editor ribbon tab. This command shows all the subassemblies and their associ-
ated settings at a specific location on the corridor. These settings can be overrid-
den one corridor section at a time, or the overrides can be applied to a range of 
stations. The changes you make here are stored as overrides within the corridor.

Exercise 10.1: View and Edit with the  
Section Editor
In this exercise, you’ll use the Section Editor to view the corridor design for 
Jordan Court in section view and then remove unwanted ditches from the design.

	 1.	 Open the drawing named Using Section Editor.dwg located in the 
Chapter 10 class data folder.

▶

If you haven’t already 
done so, download 
and install the files for 
Chapter 10 according 
to the instructions 
in the this book’s 
Introduction.
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	 2.	 In the left viewport, click one of the blue corridor lines to select the 
corridor. Then click in the upper-right viewport, and click Section 
Editor on the ribbon. 

The view shown in the upper-right viewport changes to display a 
cross section of the corridor at the location you picked before launch-
ing the Section Editor command (see Figure 10.2).

F i g u re    1 0 . 2    A section view shown by the Section Editor command

	 3.	 In the left viewport, zoom out until you can see the plan view  
of the site as well as the Jordan Court profile view. On the ribbon, 
click the Go To Next Station icon to advance to the next corridor sec-
tion. Continue advancing to view several different corridor sections. 

	 4.	 On the ribbon, expand the list under Select A Station, and select 
1+75.00' (0+050.00 m). Zoom in to the section view, and note the 
ditches on either side of the road. 

The ditches were added automatically because the road is in a cut 
condition; however, the amount of cut is so small that the ditches 
can be omitted. You’ll make this change in the next few steps.

	 5.	 Click Parameter Editor on the ribbon. This opens the Corridor 
Parameters window.

	 6.	 In the Corridor Parameters window, scroll down to Left Daylight and 
change the value for Backslope Width and Foreslope Width to 0.000. 
Repeat for the Right Daylight subassembly.

	 7.	 Click Close on the ribbon to close the Section Editor and return 
the drawing to its normal state. If you zoom in to the plan view, 
you’ll notice that the ditch has been omitted, but only at one location 
in the corridor (see Figure 10.3). 

You need to apply this change across a number of corridor sections.

Notice the line mark-
ers that indicate your 
location in plan and 
profile view. 

◀

◀

The Backslope Width 
and Foreslope Width 
values define the width 
of the ditch. When you 
set them to zero, the 
ditch will disappear. 
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F i g u re    1 0 . 3    The ditches have been removed, but only at a single station 
within the corridor.

	 8.	 Click one of the blue corridor lines, click in the upper-right viewport, 
and then click Section Editor on the ribbon. Select station 1+75.00' 
(0+050.00 m) again.

	 9.	 On the ribbon, click Parameter Editor.

	 10.	 On the ribbon, click Apply To A Station Range.

	 11.	 In the Apply To A Station Range dialog box, click the Pick button 
next to Start Station. Pick a point in the left viewport just northwest 
of the ditches.

	 12.	 Repeat the previous step for the End Station value, this time picking 
a point to the southeast of the ditches.

	13.	 Click OK to dismiss the Apply To A Station Range dialog box, and 
then click Close to close the Section Editor.

	 14.	 Click the corridor, and then click Rebuild Corridor on the ribbon. The 
ditches have been removed from the corridor, as shown in Figure 10.4.

F i g u re    1 0 . 4    A plan view (left) and section view (right) of the corridor after the ditches 
have been removed

▶

This opens the Corridor 
Parameters window. 

▶

Your start station 
should be around 0+80 
(0+020), and your 
end station should be 
around 3+00 (0+090). 
You can type in these 
stations if you’re not 
sure that you’ve picked 
the right points.
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	 15.	 Save and close the drawing.

You can view the results of successfully completing this exercise by opening 
Using Section Editor - Complete.dwg.

What’s In a Name?

Think back to the previous chapter when you spent some time in Exercise 9.3 
renaming the individual subassemblies that made up the composition of the 
road. You should recognize the names Left Daylight and Right Daylight here 
in Exercise 10.1. This is an example of how spending a few extra seconds on 
bookkeeping helps things go much more smoothly when you’re further along 
in the design process. It’s an even bigger help when you’re working on a team; 
your teammates will thank you when your good bookkeeping makes their jobs 
easier and saves them time.

Creating Sample Lines
With a profile, the alignment serves as the path along which the profile is cut. 
For a cross section, the sample line assumes this role. When sample lines are 
created, they are associated with an alignment. Multiple sample lines are typi-
cally created simultaneously, so Civil 3D requires that sample lines be placed 
in a sample line group. An alignment can host multiple sample line groups 
if necessary. So the placement of sample lines in the alignment hierarchy is 
Alignment ➢ Sample Line Groups ➢ Sample Lines.

After launching the Sample Lines command on the ribbon, you’re prompted 
to select the parent alignment. Then you’re asked to name and stylize the sam-
ple lines and choose the sources that will be sampled to create cross sections. 
You can sample four types of objects: surfaces, corridors, corridor surfaces, and 
pipe networks. Finally, you’re presented with the Sample Line Tools toolbar, 
which contains an array of commands for creating and modifying the sample 
lines in a sample line group.
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On the Sample Line Tools toolbar, a pull-down menu provides several meth-
ods for placing sample lines along the alignment (see Figure 10.5). A description 
of each method is as follows:

F i g u re    1 0 . 5    The Sample Line Tools toolbar showing the different methods available for 
sample line placement

By Range Of Stations    This method creates multiple sample lines with prede-
termined swath widths at a specified increment along the alignment. It’s great 
for creating large numbers of sample lines that are evenly distributed along the 
alignment. These sample lines are perpendicular to the alignment.

At A Station    This method is probably the simplest. You supply the station 
value, left swath width, and right swath width for each sample line you want to 
place. You can specify the station value graphically by clicking a point in the 
drawing or numerically by typing the value at the command line. This method 
is good if you only need to draw a few sample lines at odd locations. These sam-
ple lines are perpendicular to the alignment.

From Corridor Stations    This method creates a sample line wherever there is 
an assembly insertion on the corridor. This is a great solution when you would 
like to create and display cross sections for design purposes. Of course, one of 
the sources for your sample lines must be a corridor.

Pick Points On Screen    As the name suggests, with this method you click 
points on the screen, in effect drawing the sample line. This is ideal for irregu-
larly shaped sample lines that have multiple vertices and/or aren’t perpendicular 
to the alignment.

Select Existing Polylines    This method yields the same result as Pick Points 
On Screen, but you use it when you have already drawn a polyline representing 
the path of the sample line.

▶

Swath width is the 
distance from the 
alignment to either the 
left or right end of the 
sample line.

Chappell, Eric. AutoCAD Civil 3D 2016 Essentials : Autodesk Official Press, John Wiley & Sons, Incorporated, 2015. ProQuest Ebook Central,
         http://ebookcentral.proquest.com/lib/osu/detail.action?docID=2052358.
Created from osu on 2017-07-18 10:51:37.

C
op

yr
ig

ht
 ©

 2
01

5.
 J

oh
n 

W
ile

y 
&

 S
on

s,
 In

co
rp

or
at

ed
. A

ll 
rig

ht
s 

re
se

rv
ed

.



	 C r e a t i n g  S a m p l e  L i n e s 	 1 9 7

Exercise 10.2: Create Sample Lines
In this exercise, you’ll create sample lines along the Jordan Court alignment.

	 1.	 Open the drawing named Creating Sample Lines.dwg located in the 
Chapter 10 class data folder.

	 2.	 On the Home tab of the ribbon, click Sample Lines. When prompted 
to select an alignment, press Enter and select Jordan Court in the 
Select Alignment dialog box. Click OK.

	 3.	 In the Create Sample Line Group dialog box, do the following:

▶▶ For Name, enter Design.

▶▶ For Sample Line Style, verify that Road Sample Line is selected.

▶▶ For Sample Line Label Style, verify that Section Name is 
selected.

▶▶ Under Select Data Sources To Sample, uncheck all but the  
second check box.

▶▶ Verify that the settings in the dialog box match Figure 10.6, 
and click OK.

F i g u re    1 0 . 6    The Create Sample Line Group dialog box

	 4.	 On the Sample Line Tools toolbar, expand the button that lists creation 
methods, and select From Corridor Stations.

◀

If you haven’t already 
done so, download 
and install the files for 
Chapter 10 according 
to the instructions 
in the this book’s 
Introduction.

◀

You’re selecting only 
the Jordan Court cor-
ridor to be sampled.

◀

The Create Sample Line 
Group dialog box opens 
because no sample line 
groups exist for this 
alignment. If one had 
existed, step 4 would 
have been skipped 
completely.
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	 5.	 In the Create Sample Lines – From Corridor Stations dialog box, 
click OK to accept the defaults and create the sample lines.

	 6.	 Press Esc to end the command. Zoom in to the left viewport, and 
examine the sample lines that have been created (see Figure 10.7).

F i g u re    1 0 . 7    Sample lines created at corridor stations

	 7.	 Save and close the drawing.

You can view the results of successfully completing this exercise by opening 
Creating Sample Lines - Complete.dwg.

Creating Section Views
Now that you have sample lines in the drawing that have captured section data 
from the sources you’ve chosen for them, you need a means by which to display 
that data in your drawing. Just as a profile needs a profile view to make it visible, 
a cross section needs a section view. Section views are similar to profile views. 
They usually display a grid and some grid labels as a backdrop to the data they 
house. The section view is dynamically linked to the sample line and associated 
data sources. This means, as with other Civil 3D objects, that if the sample or 
source data is modified, the section view will update automatically.

Certification
Objective
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Creating Individual Section Views
As mentioned previously, one extra consideration with section views is that they 
often are created in large numbers. You’ll learn how to address that challenge in 
the next section. For now, let’s focus on creating individual section views.

Exercise 10.3: Create Individual Section Views
In this exercise, you’ll create an individual section view to use for close inspec-
tion of your design at a key location.

	 1.	 Open the drawing named Creating Single Section Views.dwg 
located in the Chapter 10 class data folder.

	 2.	 In the left viewport, zoom in to the sample line labeled 13+25.00 
(0+405.00). Click the sample line, and then click Create Section 
View ➢ Create Section View on the ribbon.

	 3.	 In the Create Section View – General dialog box, verify that the fol-
lowing items are selected:

▶▶ Select Alignment: Jordan Court

▶▶ Sample Line Group Name: Design

▶▶ Sample Line: 13+25.00 (0+405.00)

▶▶ Station: 13+25.00' (0+405.00 m)

▶▶ Section View Style: Design

	 4.	 Click Next to advance to the Create Section View – Offset Range 
dialog box. 

	 5.	 Click Next to advance to the Create Section View – Elevation Range 
dialog box. 

	 6.	 Click Next to advance to the Section Display Options dialog box. Verify 
that the style selected for the Jordan Court corridor section is Design.

	 7.	 Click Next to advance to the Data Bands dialog box. Verify that Design 
Offsets is selected under Select Band Set. Click Create Section View.

◀

If you haven’t already 
done so, download 
and install the files for 
Chapter 10 according 
to the instructions 
in the this book’s 
Introduction.

Note that you can 
change the width of 
the section view by 
modifying the offset 
range.

◀

◀

Note that you can 
change the height of 
the section view by 
modifying the mini-
mum and maximum 
elevations.
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	 8.	 When prompted to identify the section-view origin, pick a point near 
the center of the upper-right viewport. 

A new section view is created in the drawing, as shown in Figure 10.8.

F i g u re    1 0 . 8    A newly created section view

	 9.	 Save and close the drawing.

You can view the results of successfully completing this exercise by opening 
Creating Single Section Views - Complete.dwg.

Style by Design

You may have noticed that many of the styles that were selected while creating 
this section view had the word design in their names. The significance of this 
is that the styles you chose were set up to aid the designer during the design 
process but may not be appropriate for final documents such as construction 
drawings. For example, the elevation and slope labels on the section would be 
much too small to read if this drawing were plotted. For design, however, they 
come in handy—enabling the designer to zoom in and quickly get information 
about key geometry. Leveraging styles by having some for design and others 
for documentation can be very useful.

Creating Multiple Section Views
For some projects, you may be required to provide documentation of cross sec-
tions at regular intervals along your design. This is especially common for road 
design projects, because a cross-section view is traditionally used to construct 

▶

This section view could 
be helpful in assess-
ing the design at a 
specific location. Note 
how the information 
is displayed in a way 
that aids in the design 
of the road. You could 
create additional sec-
tion views at other key 
locations along the 
design of the road.
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the road. Although newer techniques and technologies have replaced the use of 
cross sections to some extent, the creation of cross-section sheets is still a com-
mon practice for these types of designs.

For most projects, there are too many section views to fit on a single sheet, so 
multiple sheets are required. This means the section views must be created in 
groups that each fit efficiently in the printable area of a typical sheet. This “per 
sheet” arrangement is handled through a group plot style.

Exercise 10.4: Create Multiple Section Views
In this exercise, you’ll use a new sample line group configured for section sheets 
to create multiple sheets containing section views.

	 1.	 Open the drawing named Creating Multiple Section Views.dwg 
located in the Chapter 10 class data folder. 

	 2.	 On the Home tab of the ribbon, click Section Views ➢ Create 
Multiple Views. 

This launches the Create Multiple Section Views Wizard. The 
General dialog box is the first in a series of dialogs.

	 3.	 In the Create Multiple Section Views – General dialog box, select 
Section Sheets for Sample Line Group Name. Click Next.

	 4.	 In the Create Multiple Section Views – Section Placement dialog box, 
verify that Production is selected under Placement Options.

	 5.	 Click the ellipsis next to the path to open the Select Layout As Sheet 
Template dialog box.

	 6.	 Click the ellipsis in the Select Layout As Sheet Template dialog box to 
browse for a template file.

	 7.	 Browse to the Chapter 10 class data folder, select Sections.dwt, and 
click Open.

	 8.	 Select ARCH D Section 20 Scale (ISO A0 Section 1 To 200), and click 
OK. Verify that Group Plot Style is set to Plot By Page.

	 9.	 Click Next in each of the remaining dialogs in the Create Multiple 
Section Views Wizard, and examine the settings for each one. Click 
Create Section Views.

If you haven’t already 
done so, download 
and install the files for 
Chapter 10 according 
to the instructions 
in the this book’s 
Introduction.

◀

◀

This drawing contains a 
new sample line group 
named Section Sheets 
that distributes the 
sample lines along the 
alignment at a consis-
tent interval.

◀

This is an important 
step because it config-
ures the layout of the 
section views by estab-
lishing the size of a 
sheet, how much space 
should be allowed 
between section views, 
and so on.
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Why More Sample Lines?

As you may recall, the first sample line group you created used the From Corridor 
Stations method to create the sample lines. This creates a sample line and the 
potential for a section view at each assembly insertion of the corridor. This con-
figuration is specifically for design purposes so the designer can see a section 
view at any key point in the design if desired. Now you need to create section 
views that meet the requirements for construction drawings. For this applica-
tion, you’re often required to show cross sections at regular intervals. Here, 
the intent is related not to the design process but to documentation. Because 
you can create multiple sample line groups for any given alignment, you could 
set up one sample line group for design purposes and one for documentation 
purposes. In fact, if you use Prospector to browse to the sample line groups of 
Jordan Court in this example, you’ll find that the Design sample line group still 
exists but that the styles have been set to hide the sample lines and their labels.

	 10.	 Click a point in the upper-right viewport in the open area to the 
north of the project. Three new section sheets should be created (see 
Figure 10.9).

F i g u re    1 0 . 9    Newly created section views configured by sheet

	 11.	 Save and close the drawing.

You can view the results of successfully completing this exercise by opening 
Creating Multiple Section Views - Complete.dwg.

Sampling More Sources
So far, you have seen that corridors can be sampled and shown in a cross-sec-
tion view, but what about other sources of data? It turns out that sample lines 
can also slice through surfaces and pipe networks. In this section, you’ll learn 
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how to sample and display data from these sources. In addition, you’ll learn how 
to add more sources of data to an established set of sample lines and section 
views so you don’t have to start over when new data becomes available.

Exercise 10.5: Sample More Sources
In this exercise, you’ll add more data sources to your drawing, sample them, and 
show them in section views.

	 1.	 Open the drawing named Sampling More Sources.dwg located  
in the Chapter 10 class data folder.

	 2.	 Click one of the section views in the upper-right viewport, and  
then click Sample More Sources on the ribbon.

	 3.	 In the Section Sources dialog box, click EG under Available Sources. 
Then click Add.

	 4.	 Under Sampled Sources, verify that the style for EG is set to Existing 
Ground.

	 5.	 Verify that the Section Sources dialog box looks like Figure 10.10, 
and then click OK. 

After a pause, a red dashed line is added to each section view. This 
line represents the surface of the existing ground. In addition, a 
default label set has been applied to the existing ground line, which 
isn’t appropriate for this application. You’ll remove the labels in the 
next several steps.

F i g u re    1 0 . 1 0    Sampling additional sources using the Section Sources 
dialog box

	 6.	 With the section view still selected, click View Group Properties on 
the ribbon. 

◀

If you haven’t already 
done so, download 
and install the files for 
Chapter 10 according 
to the instructions 
in the this book’s 
Introduction.

This opens the Section 
View Group Properties 
dialog box.

◀
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	 7.	 On the Sections tab, click <Edit> in the Label Set column next to EG.

	 8.	 Select _No Labels, and click OK. Click OK again to close the Section 
View Group Properties dialog box and return to the drawing. 

	 9.	 In the top-right viewport, zoom in to the first section view at 0+50 
(0+010) in the lower-left corner of the first sheet. Pan upward, and 
examine each section view. When you get to the top of the column, 
move to the bottom of the next column and pan upward to continue 
viewing the sections in order. 

	 10.	 On the Insert tab of the ribbon, click LandXML. Browse to the Chapter 
10 class data folder, and select Preliminary Waterline.xml. Click Open.

	 11.	 Click OK to dismiss the Import LandXML dialog box. 
A new pipe network representing the preliminary design of the 

waterline along Jordan Court has been created in the drawing. If you 
zoom in to the plan view of Jordan Court, you can see the double 
blue line along the right side of the road.

	12.	 Click one of the section views, and then click Sample More Sources 
on the ribbon.

	 13.	 In the Selection Sources dialog box, click Preliminary Waterline and 
then click Add. Click OK to close the dialog box.

	 14.	 Press Esc to clear the selection of the section view. Zoom in, and 
examine the section views to verify that the waterline is being shown. 

	 15.	 Use the LandXML command to import Subsurface Rock.xml. Use 
the Sample More Sources command to add the new surface named 
Rock to the section views. Set its style to Rock.

	16.	 Once again, you need to clear the labels. Click a section view, and 
then click View Group Properties on the ribbon.

	 17.	 Click <Edit> in the Label Set column next to Rock. Select _No 
Labels, and click OK. Click OK again to return to the drawing.

	 18.	 Study the section views again. 
In a real-life situation, you may need to inform the engineer that 

the waterline design requires the excavation of a significant amount 
of rock. Also notice that around station 9+00 (0+270), the rock layer 
is very close to the surface—you may want to consider raising the 
road a bit in this area to avoid costly rock excavation.

	 19.	 Save and close the drawing.

The labels should be 
removed.

▶

▶

As you do this, try to 
visualize traveling 
down the road and 
experiencing the 
changes in the road 
geometry that you see 
from section to section.

▶

The scenario here may 
be that an engineer 
has asked you to check 
the waterline design 
against your road 
design to see if there 
are any problems.

▶

As you look at the 
section views, do you 
see any problems with 
the location of the 
waterline?
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